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Welcome to PhotoStack 

PhotoStack is the quickest, easiest way to view, sort, enhance and share 
your photo collection, so you can treasure every photo and make them 
brilliant. You’ll be able to import, map, adjust, and share, from a main 
Library view. 

 

Significantly faster than other photo managers, PhotoStack 
automatically sorts your photos so you can quickly access what you 
want, when you want. Find and choose your shots, then crop, fix, 
enhance with easy tools, and share however you wish, as files, online, by 
email, or in print. 

PhotoStack is your photo collection made easy, fast, and fantastic, and is 
the ideal companion to PhotoPlus, PanoramaPlus or creative programs 
like CraftArtist, PagePlus and WebPlus, whether managing photos for 
yourself or for sharing. 

 Don’t forget to register your new copy using the Registration 
Wizard on the Help menu.  
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Key Features 

Before you get started with PhotoStack, we recommend you familiarize 
yourself with PhotoStack key features. 

• An intuitive user interface 
The PhotoStack workspace puts your collection first, with the 
useful tools you need close by. 

• Learning Assistant 
The Learning Assistant starts when you first launch 
PhotoStack, showing you the latest news and learning 
resources. 

Flexible importing 

• Import photos from anywhere (p. 13) 
Import photos into your library from virtually anywhere—a 
DSLR camera, memory card, USB drive, Smartphone, 
computer or network. 

• Broad compatibility 
A wide range of file types are supported including popular 
standard photo formats, camera RAW files, deep-colour 16-bit 
per channel photos such as HDR shots, plus audio and video. 

• Smart import options  (p. 14) 
Automatically optimize photos for fast searching and sorting by 
tagging on import and creating photo stacks. Options allow 
you to easily copy photos, rename files, and delete imported 
files from USB devices as part of the import process. 

• Watch folders (p. 16) 
Include folders to let PhotoStack automatically add new files to 
your Library as soon they appear. 
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View, search and manage your photos 

• A new home for your photo collection (p. 19) 
Your PhotoStack Library houses all your photos from different 
sources in a super-fast collection, with custom thumbnail sizes, 
single photo view, full screen mode and a slideshow feature. 

• Quickly view any photos (p. 22) 
View specific photos from large collections in almost no time 
just by clicking tags like camera metadata, dates, or ratings 
and descriptive tags of your own. Apply tags by drag-and-drop 
to individual photos or multiples, so your collection is always 
easy to sort and search. Split the thumbnails into distinct 
groups for easier viewing, and combine search criteria as filters 
for fine control.  

• Smart search 
Be selective about what you want to see using a smart search 
tool, with key words helping you drill down to quickly find the 
photos you're after.  

• Rotate and flip (p. 88) 
Easily rotate photos in 90° increments so they're the right way 
up, or flip to change the composition.  

• Create stacks and albums to be organized (p. 38) 
Add photos into stacks, a smart album, or permanent albums 
to keep them tidy, quick to browse, and easy to print and share.  

• Put your photos on the map (p. 53) 
See and place photos on an interactive Google Map, right 
down to Street View accuracy – even draw a custom region on 
the map to see the photos that were taken there.  
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• Quick tags (p. 43) 
Flag photos to keep or discard, to print, and to fix using quick 
buttons to make larger collections and photo shoots simple to 
manage. 

• Archive your photos 
Back up your collection to an external drive or other media 
with a simple process for your whole collection, or just new 
photos added since your last back up. 

Easy photo editing 

• One-click photo edits (p. 70) 
Editing is easy with one-click presets for corrections and 
adjustments, or for stylish effects such as retro, black and white, 
and film grain. 

• Lifelong edit history 
Make as many changes as you like without original photos 
being overwritten. All edits are permanently available in a 
History, beyond your current editing session.  

• Fix photo flaws (p. 76) 
Perform popular retouch tasks like crop, straighten, fix red eye, 
remove blemishes, and remove unwanted objects. 

• Professional adjustments (p. 72) 
Carry out professional edits to white levels, colour tones, 
highlights, shadows and midtones, and much more, using fine-
control adjustments. 

• Create new versions of photos (p. 75) 
Make snapshots at any time—new versions of photos that are 
automatically stacked with the original for easy management. 
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• Before-and-after view 
View a live before-and-after comparison of your edits with a 
draggable splitter. 

• Mask areas to limit effects and adjustments (p. 83) 
Use a smart brush with edge-detection to create areas of a 
photo to apply effects and adjustments to, or to protect from 
changes. 

• Gradient masks (p. 85) 
Add depth, stylish touches of colour and more with gradient 
masks that blend the strength your effects and adjustments 
over height or distance. 

• Send photos to other Serif products 
If you own these other PhotoPlus, PanoramaPlus or 
CraftArtist (p. 89, p. 90, p. 91), you can transfer photos straight 
from PhotoStack for further editing or for including in creative 
projects. 

Share your photos your way 

• Share albums and selections (p. 95) 
Share selected photos, your smart album, or albums you've 
created using one-click sharing presets that speed up and 
simplify output. 

• Share online (p. 105-112) 
Upload photos straight to Facebook, Flickr, or Dropbox from 
within PhotoStack. 

• Email photos to friends and family (p. 103) 
Attach photos to an email; PhotoStack will automatically 
optimize them for on-screen viewing and smaller email sizes. 
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• Quick prints and stylish print layouts (p. 102) 
Print single photos and collections in stylish drag-and-drop 
print layouts. Edit your layout in a live preview, even make new 
print layouts of your own.  

• Easy photo exports (p. 100) 
Export to a new file or file set, using output presets or your own 
choice of format, compression, size, and more.  

• Watermarks (p. 112) 
Protect your photos with a watermark using a unique 
watermark builder. 

• Save your favourite output options (see PhotoStack Help) 
Create output settings of your own combining your preferred 
photo settings and actions. 

Built for speed! 

PhotoStack makes viewing and sorting your photo collection a pleasure 
thanks to its class-leading speed! 

• A brand new organizer engine 
PhotoStack is optimized for both 64-bit and 32-bit systems, and 
can handle collections of just about any size.  

• Optimized for speed 
Multi-core systems gain a further boost, with background tasks 
that let you carry on browsing while the hard work goes on 
behind the scenes. 
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Installation 

Installing PhotoStack follows different procedures depending on 
whether you are installing from disc or via download. 

 32 or 64-bit PhotoStack installs to respective 32 or 64-bit computers. 

Installation procedure (from disc) 

• Insert your purchased disc into your disc drive. 

o If AutoPlay is enabled on the drive, this automatically 
starts the Setup Wizard. Follow the on-screen 
instructions for install. 
 
-or- 

o If AutoPlay is not enabled (or doesn't start the install 
automatically), navigate to your program disc and 
double-click autorun.exe. 

Installation procedure (from download) 

• From serif.com, when logged into your Serif account, follow 
the on-screen instructions to download. 

http://www.serif.com/
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System Requirements 

Minimum: 

• Windows-based PC with CD/DVD drive and mouse 

• Operating systems: 
Microsoft Windows® XP SP3 (32 bit) 
Windows® Vista (32 or 64 bit) 
Windows® 7 (32 or 64 bit) 
Windows® 8 (32 or 64 bit) 

• 512MB RAM (1GB RAM for 64-bit operation) 

• 361MB free hard disk space 

• 1024 x 768 monitor resolution 

Optional: 

• Windows-compatible printer 

• Internet account and connection required for accessing online 
resources and Map view.  
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Importing photos 

Adding photos to PhotoStack simply means opening a "window" to your 
operating system. The photos will be displayed in the Library but will 
always remain in their original location while using PhotoStack. 

PhotoStack lets you: 

• Add and watch folders already present on your computer disk 
(see p. 16). 

• Import photos from a USB device (cameras, flash drives), 
external hard drive, CD or DVD, copying the photos to your 
computer (see p. 14). 

• Include photos from a fixed hard drive, either: 

o leaving photos in their original folder location (see 
p. 15). 
 
OR 

o copying photos to a new folder.  

Photos may be imported into PhotoStack from USB devices (cameras, 
removable USB flash drives, card readers, external hard drives),  from 
DVDs/CDs, and from local hard drives at any time. The process 
involves the transfer of photos from the device to a user–defined file 
folder. The photos are then automatically added to the Library. 

Similarly, the import process optionally lets you include photos from 
another hard drive on your computer. By default, the photos remain in 
their original locations but can be copied locally as well. 
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To import individual files from a USB device:  

1. From above your workspace, select  Import. 

2. In the Import Photos dialog, in the From drop-down list, 
select a source for your files. 
 

 
 
The Photos window will be populated with photos on the 
selected device. 
 

 

3. To exclude photos from import, uncheck the check box on the 
photo's thumbnail. 

 To select or deselect all the photos in the Photos window in bulk, 
click Check All or Uncheck All, respectively. 

4. (Optional) Specify the Transfer Options and Descriptive Tags 
for the photos (see PhotoStack Help for details). 

5. Click OK. 
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The photos on the device are imported into the PhotoStack Library and 
are also copied to the folder specified in the Import Photos dialog under 
Transfer Options. The default specified folder is your Microsoft 
Windows Pictures folder. 

 If your USB device or external hard drive does not appear in the 
From drop-down list, ensure it is correctly connected and then, 
from the From drop-down list, select Refresh Devices. If this does 
not resolve the issue, check All Portable Devices at the top of the 
dialog, then display the drop-down list again. 

To import photos from a DVD (or CD): :  

1. From above your workspace, select  Import. 

2. In the Import Photos dialog, in the From drop-down list, 
select Browse. 

3. In the Browse For Folder dialog, navigate to, then select the 
DVD or CD containing your photos. 

4. Click OK. 

5. Follow the procedure for importing from USB devices (from 
Step 3 above). 

To include photos from other local hard drives:  

1. From above your workspace, select  Import. 

2. In the Import Photos dialog, in the From drop-down list, 
select Browse. 

3. In the Browse For Folder dialog, navigate to, then select the 
local hard drive and the folder containing your photos. 

4. Click OK. 
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As you're including photos from their original location, the Include 
Photos option is enabled and, by default, Transfer and Tagging options 
are greyed out.  

 If you want to copy photos from another local hard drive, enable 
Import Photos instead of Include Photos. You can then specify your 
transfer and tagging options. 

Adding and watching folders 

Rather than importing individual photos to the Library (see p. 13), you 
can include specific computer disk folders in PhotoStack. Including a 
folder in PhotoStack achieves two things: 

• All photos in the selected folder will be added to the Library. 

• The folder will be automatically "watched". This means that any 
photos subsequently added to the included folder are 
automatically displayed in PhotoStack. 
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To include a folder in PhotoStack: 

1. On the Organize tab, under the All photos section, click 
 Include folder. 
 

 

2. In the Browse For Folder dialog, navigate to, then select the 
folder containing your media files. 

 If you select a folder on a disc or removable drive, you will receive a 
message asking if you wish to import the photos to PhotoStack. 
Click Yes to continue to the import process (see p. 13), or click No to 
cancel the include folder operation. 

3. Click OK. 

The files from the chosen folder will be added to the Library, with the 
folder name being added to the Organize tab. 
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Managing folders 

Your folder structure in Windows may be just how you want it. 
However, PhotoStack makes an easy job of creating and managing 
folders directly from the Organize tab. 

You'll then be able to drag and drop photos into your new folders, 
creating a new Windows folder hierarchy from within PhotoStack. 

To create a new folder: 

1. On the Organize tab, right-click an existing folder name (listed 
under All photos) and select New Folder from the flyout. 
 

 

2. Enter a folder name in the highlighted text, overwriting the 
"New folder" text. 
 

  

3. Press the Return key. 
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 A folder can be created from any folder in PhotoStack, always being 
created as a subfolder. 

Once folders are added to PhotoStack (see p. 16) or created, you can 
manage them in various ways from the same right-click flyout. 

• Open Folder: Displays the folder and its contents in a standard 
Windows window. 

• Rename Folder: Changes the folder's name in PhotoStack and 
Windows. 

• Remove Folder from PhotoStack: Removes the folder and its 
contents from PhotoStack and, optionally, deletes the folder 
and its contents from your computer (if selected in the Remove 
Folder dialog). 

Viewing photos in the Library 

Photos which have been added or imported into PhotoStack are typically 
displayed in the Library. 

To access the Library: 

• From above your workspace, click Library. 
 
Your photos are displayed as thumbnails in the main 
workspace. 

There are many ways in which you can view your photos in the Library. 
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To view your photos in the Library: 

• Hover the mouse over a thumbnail to see a flyout preview 
including the file's metadata. 
 

 

• Double-click a thumbnail to see it at the maximum size within 
the Library. Double-click again to minimize.  

• Use the Page Down key on your keyboard to move down 
through the Library or, while in maximize view, move to the 
next photo. 

• Use the Page Up key on your keyboard to move up through the 
Library or, while in maximize view, move to the previous 
photo. 

•  Use the magnification slider on 
the Status Bar to zoom in or out. Alternatively, click on the 
adjacent Zoom Out and Zoom In icons for magnification in 
increments. The aspect ratio for each thumbnail is maintained. 
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• The photo can be launched in Serif PhotoPlus (see Editing your 
photos in PhotoPlus on p. 89)—especially if you want to 
perform some advanced editing of the photo. Also open your 
photo in Serif PanoramaPlus (see p. 90) or Serif CraftArtist (see 
p.  91). 

Selecting photos 

Before looking at each of the operations that can be used to manage your 
photos it’s worthwhile familiarizing yourself with the different options 
available for selecting thumbnails. Selection is the precursor to 
performing an operation. 

The main methods of selection are: 

• Single click: A click on the thumbnail will make it selected so 
that the thumbnail is shaded in grey. 
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• Drag select: This can typically be used for selecting more than 
one thumbnail simultaneously. Click next to a thumbnail, hold 
your mouse button down and drag over your required 
thumbnails. Release the mouse button when you're happy with 
the selection. 
 

 

• To select all displayed photos, use Ctrl+A. 

• If your photos are grouped (see p. 35), double-click the group's 
title bar to select all photo thumbnails in that group. 
 

 

Creating albums 

Albums are a great way of organizing your photos. They allow you to 
group photos in a variety of ways and are independent of photo folder 
location, date taken, tags, and ratings. Plus, the great thing about 
PhotoStack albums is that photos can appear in more than one album 
without that photo been replicated time and again! There are no limits 
to the number of albums you can create and store in PhotoStack. 
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PhotoStack albums differ from Smart albums as they are populated 
manually by various methods and do not have to be based on specific 
photo properties. 

 For more information on creating automatic albums using photo 
properties, see Creating smart albums on p. 29. 

To create an album:  

1. (Optional) In the Library, select photo thumbnail(s) (see p. 24).  

2.  On the Organize tab, from the Albums section, click 
Create album. 

3. In the Create Album dialog: 
 

 

o Type a name for your album in the Album Name 
input box. 

o To create an empty album, select Initially Empty. 
 
OR 

o To create an album based on your current selection, 
select Populate album using selection. 
 
OR 
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o To create an album using photos in your Quick album 
(see p. 28), select Populate album using Quick 
album. You can also remove the photos from your 
Quick album simultaneously by selecting the Clear 
Quick album after creating album option. 

4. Click OK. 

The album is created and added to the Albums section of the Organize 
tab. 
 

 

To rename an album: 

1. Right-click the album name on the Organize tab and select 
Rename Album. 

2. Type in a new album name. 

To delete an album: 

• Right-click the album name on the Organize tab and select 
Delete Album. You'll be prompted to confirm that you want to 
delete the album. 
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Quick album 

A Quick album is included in PhotoStack for immediate use. This could 
be used for temporarily grouping photos (e.g. ready for sharing) or as a 
precursor to creating a new album. 

To add a photo to a Quick Album: 

• In the Library, click in the top-right corner of any photo. 

The photo is now included in the Quick album (shown in the Organize 
tab), as indicated by the thumbnail's  icon. Photos can be easily 
removed from the Quick album so it can be used to organize other 
photos. 

To remove a specific photo from the Quick Album: 

• Click the  icon in the thumbnail's top-right corner. 

To remove all photos from the Quick album: 

• Right-click any album name on the Organize tab and select 
Clear Quick Album. 

 The Quick album cannot be renamed or deleted. 

Populating albums 

You can add photos to albums by drag and drop. 

To add photos to an album: 

1. In the Library, select photo thumbnail(s) (see p. 24). 

2. Drag your selection onto an album on the Organize tab. Blue 
shading will appear around the selected album. 
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OR 
 
Drag an album name, from the Organize tab, over any selected 
photos. Blue shading will appear around the selected 
thumbnail(s).  

Your photos are placed in the selected album. 

 To indicate that photos belong to a named or Quick album, select 
View>Photo Details>Album.  

An  or  icon will appear on the thumbnails, respectively. 

To remove photos from an album: 

• Right-click one or more selected thumbnails, and select an 
album from the Delete from Album flyout submenu. 

Creating smart albums 

A powerful feature of PhotoStack is the ability to create smart albums. 
These are collections of photos that are created and stored as a result of a 
search for photos that possess inherent photo properties. Searches could 
include specific Date Taken times, File Formats, and Names as well as 
user-defined Tags and Ratings. Smart album creation also lets you build 
up multiple search conditions using "AND" or "OR" operations. 

If, in the future, you import any photos that match the smart album's 
criteria, PhotoStack will automatically add them to the album.  
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To create a smart album:  

1.  On the Organize tab, from the Smart albums section, click 
Create smart album. 

2. In the Create Smart Album dialog, type an Album Name. 
 

 

3. From the Search Conditions options, select an "AND" or "OR" 
condition for use with multiple search conditions. 

4. From the drop-down list, select a photo property. 
 

 
 
The adjacent drop-down lists change according to the type of 
search condition chosen. For example, the Date Taken 
condition can be set to be on, before, after, between, or since a 
set date. 
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5. Click Add. The search condition is added to the list box. 

6. Repeat from steps 4 and 5 to add further search conditions to 
the search condition list. 
 

 

7. Click OK to exit the dialog. 
 
The album is created and added to the Smart albums section of 
the Organize tab. 
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To edit a smart album: 

1. Right-click the album name on the Organize tab and select 
Edit Album. 

2. For renaming, edit the Album Name. 

3. To change any search condition, double-click it, edit the upper 
drop-down lists, and click Update. 

To delete a smart album: 

• Right-click the album name on the Organize tab and select 
Delete Album. You'll be prompted to confirm that you want to 
delete the album. 

Changing thumbnail display 

By default, your photos will display in PhotoStack as thumbnails with 
their file names. However, you can display additional photo details on 
each thumbnail such as Rating, Date Taken, Time Taken, and more.  

 

Thumbnails displaying no photo details (left) and with Rating, Date 
Taken, and Time Taken shown (right). 
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As you organize your photos, 
each thumbnail may also 
display overlaid symbols 
indicating that the photo is: 

 tagged 

 added to an album 

 geo tagged 

 edited in Develop view 

 added to Quick Album 

This is dependent on 
View>Photo Details being set 
to 'All'. 

To display photo details on thumbnails: 

• On the View menu, select Photo Details, and choose an option 
from the menu flyout. 
 

 
OR 

• To display all photos details, select the 'All' option. 

 If you click the thumbnail's  Geotag indicator, the location where 
your photo was taken is shown in Map view. 
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Sorting photos (changing displayed 
order)  

The thumbnails displayed in PhotoStack can be sorted using the 
following sort criteria: 

• Date Taken (time that photo was taken; from Exif) 

• File Creation Date (time copied to hard disk) 

• File Modified Date (time the file was last modified) 

• Rating 

• File name 

• Duration (for audio and video files) 

 The file date and times for the selected photo are displayed in the 
Metadata tab. 

To change thumbnail sort criteria: 

• On the View menu, from the Sort By menu flyout, select a sort 
criteria. 
 

 

By default, thumbnails are ordered in ascending order. This order can be 
reversed by changing it to a descending order. 
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To reverse thumbnail order: 

• On the View menu, from the Sort By menu flyout, uncheck 
Ascending. 

Grouping photos 

To help you view your photos in the Library, PhotoStack groups 
thumbnails together. By default, groups are displayed according to 
folder name, although PhotoStack allows you to group by a variety of 
other grouping criteria. 

Viewing groups 

For example, when selecting Date taken on the Organize tab, the 
following Library thumbnail display is typical: 
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A dark grey title bar indicates the beginning of a new group and also 
allows you to navigate easily between groups. 

To navigate between groups: 

• On the right side of the title bar, click the  arrows to move 
to the previous or next group, respectively. 

• On the left side of the title bar: 

o Click the  collapse arrow to collapse the group and 
hide its photos. 

o Click the  expand arrow to expand the group and 
display its photos. 

Changing grouping criteria 

The default, automatic grouping behaviour can be changed so that files 
are always grouped in a specific way, regardless of what is selected on the 
Organizer tab. Additionally, by default, groups are ordered in ascending 
order. This order can be reversed by changing it to a descending order. 

The thumbnails displayed in PhotoStack can be grouped using the 
following grouping criteria. 

• Album: The album within which photos are located. 

• Folder: The folder name within which photos are located. 

• Date Taken: The date and time that photos were taken (from 
Exif). 

• File Type: The file type of photos, e.g. JPEG or PNG. 

• Rating: The rating previously assigned to photos. 

• Tag: The Descriptive tags previously assigned to photos. 
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• QuickTag: The Quick tags previously assigned to photos. 

• Music Genre: The genre previously assigned to audio files. 

• None: Photos are not grouped. 

To change grouping criteria: 

• On the View menu, from the Group By menu flyout, select a 
grouping criteria. 
 

 

 To return to automatic grouping, select Auto from the View menu's 
Group By menu flyout. 

To change grouping order: 

• On the View menu, from the Group By menu flyout, uncheck 
Ascending. 
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Stacking photos 

PhotoStack allows you to stack photo thumbnails on top of each other to 
further organize thumbnails on display. This means your very best 
photo, or the photo that best represents your stack, can be used. 

You may want to stack photos together for several reasons: 

• To group by similar subject matter. 

• For workflow, where deficient stacked photos can be tagged as 
"To Fix". 

• For stacking a generated panorama and its source photos. 

• For stacking "bracketed" photos taken at different exposures. 

To create stacked photos: 

1. In the Library, select photo thumbnail(s) (see p. 24). 

2. On the Edit menu, from the Stack menu flyout, select Create 
Stack.  

The photo stack is clearly indicated by a white border. 

To expand and collapse a stack: 

• Click the expand button (indicated below), to reveal all the 
photos in the stack. 

• Click the collapse button to hide them again. 
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 When you import photos from USB devices (see p. 14), PhotoStack 
allows you to automatically create stacks of photos based on 
dates/times or duration (see PhotoStack Help). 

To unstack a selected photo stack: 

• Select the photo stack, then on the Edit menu, from the Stack 
menu flyout, select Unstack.  

To set which photo shows at the top of stack: 

• From an expanded stack, right-click the photo and select Set 
Stack Top from the Stack flyout. When the stack is collapsed, 
your chosen photo displays. 
 

 

To add more photos to a stack: 

• Drag and drop a photo onto your stack.  

To remove a photo from a stack: 

• From an expanded stack, right-click the photo and select 
Remove from Stack from the Stack flyout.  
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Tagging photos 

Tagging is one of the best ways of organizing your photos as it allows 
you to identify similar or themed photos regardless of their file name or 
the folder in which they reside. It also allows you to access one of the 
most powerful features of PhotoStack—Filter by tag (see p. 64). 

If photos have been tagged before they are imported to PhotoStack (see 
p. 13), they will be automatically tagged in PhotoStack. These tags will 
also automatically be added to the Descriptive tags category on the 
Organize tab. 

PhotoStack also comes with preset "action-based" tags and Quick tags to 
help identify photos which require further action, e.g. Reviewed, To Fix, 
To Print, and To Share. However, for more personalized tagging it's 
possible to manually create your own tags from the same tab. 

Assigning tags to photos 

Tags can be assigned to your photos in several different ways. 

To assign a tag to a thumbnail: 

1. In the Library, select photo thumbnail(s) (see p. 24).  

2. Drag your selection onto a tag name on the Organize tab. Blue 
shading will appear around the selected tag. 
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OR 
 
Drag a tag name, from the Organize tab, over any selected 
photos. Blue shading will appear around the selected 
thumbnail(s).  

Your assigned photos can then be displayed by tag name. See Filter by 
tag on p. 64. 

 To indicate that photos have been tagged, select View>Photo 
Details>Tag. An  icon will appear on the thumbnails. 

To remove tags from thumbnails: 

• Right-click one or more selected thumbnails, select Detach 
Tag, then select the tag to be removed. 

Creating tags 

You can create your own tags to help organize your photos. These can 
range from simple standalone tags, to sets of complementary tags (for 
multi-tagging purposes), to complex hierarchy tagging systems for 
regimented photo management. 

To create tags: 

1. On the Organize tab, click  Create tag. 

2. Type a new tag name in the highlighted text box. 
 

 

3. Press Return.  



42 Organizing 

 

The tag structure is updated to display your new tag. 
 

 

To create a tag hierarchy: 

You can nest tags within tags for "parent-child" tagging—simply drag 
one tag onto another. A typical example would be placing year tags 
under a general annual celebration tag or grouping regular events 
together. 

 

 There is no limit to the depth of tagging allowed. 

 Tags can be promoted to a higher level by dragging to a 
"grandparent" tag or onto the top-level Descriptive tags label. 

To rename a tag: 

1. Right-click a tag name and select Rename Tag. 

2. Type a new tag name in the highlighted text box. 
 
When you're happy with the new tag name, click Return.  
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Quick Tags 

Although Quick tags can be assigned to photos in the same way as 
Descriptive tags (see p. 43), and allow for similar filtering (see p. 64), 
they function in a different way. 

Quick tags are used temporarily to mark photos specifically for further 
action to be performed on them. For example, you could import a range 
of photos, filter on the Date taken, then flag photos before you add to 
album, tag them, rate them, or apply adjustments. Unwanted photos can 
simply be marked as rejected. 

To flag or reject selected photos: 

• Drag photos onto the  Flagged or  Rejected Quick tag.  

To unflag or not reject selected photos: 

• Drag photos onto the  Not flagged or  Not rejected 
Quick tag. 

 Photos marked as Rejected are not removed from PhotoStack or 
deleted from your computer. The tag is for organizational purposes 
only. 

Rating photos 

Any photo can be allocated its own star rating. This is really useful when 
you want to categorize your favourites—you simply assign a rating to 
your photos and subsequently filter your photos by rating. See Filter by 
rating (see p. 66). 

Ratings can be from one star to five stars (maximum); five stars would 
normally be allocated to your favourite photos. 
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To rate your photos: 

1. In the Library, select photo thumbnail(s) (see p. 24).  

2. Drag your selection onto a rating level on the Organize tab. 
Blue shading will appear around the selected rating. 
 

 
OR 
 
Drag a rating level, from the Organize tab, over any selected 
photos. Blue shading will appear around the selected 
thumbnail(s). 
 
OR 
 
Press the 1 to 5 key (or 0 as unrated) on your keyboard. 

 To indicate that photos have ratings assigned, select View>Photo 
Details>Rating.  An icon (e.g., ) will appear on the 
thumbnails. 

To unassign a star rating: 

• Drag-and-drop your rated photo onto the Not rated option in 
the Ratings section. 
 
OR 
 
Press the 0 key on your keyboard. 
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Changing date and time 

Most photos have date and time settings associated with them, obtained 
from your camera's Exif data. The most important setting is the date and 
time that photo was taken, which is displayed as the Date Taken setting 
in PhotoStack's Metadata tab. 

The Date Taken setting can be modified for several reasons. 

• When on holiday or business, your digital camera’s time zone 
settings were not adjusted—meaning that the Date Taken 
setting is incorrect. 

• Your digital camera’s time setting was not adjusted for daylight 
saving—meaning that the time is an hour out. 

• If you have a photo that was scanned, although the file creation 
date will be used, you can update the setting to reflect the time 
the photo was taken rather than when it was scanned. 

 For information on how to filter by date, see Filter By date (on p. 63). 

 Changing a photo's date and time is permanent. We advise  caution 
when using the processes below, particularly when applying a 
specific date and time to multiple photos. 

To change a photo's Date Taken setting: 

1. In the Library, select a single thumbnail (see p. 24).  

2. Click to display the Metadata tab. 

3. Double-click the Date Taken field. 
 

 



46 Organizing 

 

4. In the Date Taken dialog: 

o From the  Date drop-down calendar, select a date. 

o In the Time input box, type a time or use the arrows 
to select a time. 

o Click OK. 

 The time is always displayed as the 24-hr clock. 

Changing time zones (changing photo dates/times 
in bulk) 

Suppose you’re on holiday and in your excitement you forget to adjust 
the time settings on your digital camera upon arrival—assuming you’ve 
gone somewhere hot, sunny and far away! You’ve returned home to find 
that photo Date Taken settings are incorrect. Don’t panic—it is possible 
to adjust this date/time. 

To change a photo's time zone: 

1. In the Library, select photo thumbnail(s) (see p. 24).  

2. On the Edit menu, select Time Zone.  
 
The Time Zone dialog appears for updating the date and time 
of the selected photos. 

The Relative date/time adjustment is best when adjusting multiple 
images in one batch as it preserves the time differences between each 
image. 
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To set a relative date: 

1. Select Date Taken from the Type drop-down list. 
 

 

2. Select Relative and then: 

o To add time, select Add. 

o To remove time, select Remove. 

3. In the Days, Hours, and/or Mins input boxes, type a number 
by which to adjust your date and/or time. 

4. Click OK. 

The settings in the dialog above will fix photos with an incorrect date 
and time if a holiday had been taken in Finland (GMT+2 hours) from 
the UK (GMT). 

Setting a specific date and time may be preferred if calculating the 
difference between the photo’s currently set Date Taken time and the 
required date is too complicated, or if you know the exact date/time for 
your photos, e.g. those from a New Year celebration. 



48 Organizing 

 

To set a specific date and time: 

1. Select Date Taken from the Type drop-down list. 
 

 

2. Select Specific. 

3. From the  Date drop-down calendar, select a date. 

4. In the Time input box, type a time or use the arrows to select a 
time. 

5. Click OK. 

All selected photos are updated to the time stated (e.g. 9:28am on 15 
September 1984). This will mean all selected photos will have exactly the 
same time and date. 

 You can also update dates and times for a photo's File Creation 
Date and/or File Modified Date via the Type drop-down list in the 
Time Zone dialog. 
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Deleting photos 

Photos can be deleted at any time—you'll actually be deleting the photo 
from your computer, so caution should be taken. 

To delete a photo: 

1. In the Library, select photo thumbnail(s) (see p. 24).  

2. Press the Delete key (or select Edit>Delete). 

 This method will permanently delete the original file from your 
computer. 

You'll get a confirmation message asking if you want to delete your 
photos from disk. If Yes is selected, your photo(s) will be sent to your 
recycle bin (restore from there if you want to revert). 

Viewing and adding metadata 

PhotoStack displays essential photo and file information exclusively in 
the Metadata tab. This information is a mix of EXIF and IPTC 
metadata. 

This information comprises: 

• File properties (File Name, Dimensions) 

• Photo properties* (Date Taken) 

• Photo information (Caption, Tags, Rating, Author, Copyright) 

• Camera specifications* (Make and Model) 

• Shoot details* (ISO rating, Focal Length, Exposure, Aperture, 
Shutter Speed, Flash, White Balance, etc.). 
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* When using your digital camera, this EXIF information is associated 
with your photo irrespective of its file format (RAW, JPG, or otherwise). 

To display metadata for a selected photo: 

• Click to display the Metadata tab. 

The metadata is arranged into name/value fields, of which some are 
editable, e.g. Date Taken, Tags, Rating, Author, Copyright, and Caption. 
(Uneditable fields are greyed out.) 

To modify metadata: 

• Double-click on one of the above fields and type or paste new 
text. 

Advanced View 

You can display a detailed breakdown of your metadata in its EXIF or 
IPTC structure. 

To display EXIF or IPTC data for a selected photo: 

• On the Metadata tab, select the drop-down arrow next to either 
More Exif or More Iptc. 

The tab expands to reveal EXIF and IPTC metadata in separate sections. 
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Mapping 

Map view displays a Google™ map pane in the main area of your 
workspace. This allows you to navigate your Google map, view Geo-
tagged photos automatically placed on your map (as pins), and then 
view photos in turn. PhotoStack also lets you manually position non-
geo-tagged photos on your map easily. 

 

(A) Pan tool, (B) StreetView tool, (C) Zoom buttons/slider, (D) Map, (E) 
Type toolbar, (F) Photo Geo-Tag pins, (G) Descriptive tag Geo-Tag pins, 

(H) Photos pane. 

To display PhotoStack's Google map: 

• From above your workspace, click  Map. 
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 To return to the Library, click  Library above your workspace. 

Geo-Tagging 

Geo-Tagging is the process of adding geographical location data to your 
photos. The Geo-Tag data is contained within the photo's Exif metadata. 

There are a few cameras on the market that can automatically add Geo-
Tag data to photos as they are taken—the Latitude and Longitude co-
ordinates are written into the metadata of the respective photos. These 
are displayed on PhotoStack's Google™ map immediately and require no 
further editing. However, if your camera doesn't have this functionality, 
you can easily Geo-Tag your photos in PhotoStack. 

To add Geo-Tag data by drag-and-drop: 

1. From above your workspace, click  Map. 

2. Find the photo location on the map and zoom to an 
appropriate level. 
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3. Select your photo(s) from the lower pane and drag onto the 
map. 
 

 

4. Release the mouse button when you’re happy with the position. 

Geo-Tagged photos are represented on the map by red pins. Multiple 
photos will show as a grouping of pins. 

 

 When a Geo-Tag is represented by a single pin, you can easily 
reposition it by dragging it to a new location. This is not possible 
when a group of pins is displayed. 

To delete a Geo-Tag: 

• In Map view, click the pin(s) to display an information bubble 
and then click Delete Geo-Tag(s). 
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OR 

• In the lower Photos pane, select one or more photos, right-click 
and select Delete Geo-Tag. 

Viewing information and photos 

Geo-Tagged photos are represented on the map by red pins. Depending 
on the number of photos associated with the Geo-Tag, and on the zoom 
level, these may appear as either a single pin or as a group of three pins. 

To locate Geo-tagged photos on the map: 

• In the Library or from the Photos pane (Map view), click a 
thumbnail's  Geo-tag icon. 

The main workspace will switch to Map view (if not already in Map 
view) and display the photo's Geo-tag pin (in a central position). 

To view information associated with a pin: 

• Click the pin to see an information bubble. 
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The information and options provided in the information bubble are 
slightly different for single photos and multiple photos. Latitude and 
Longitude co-ordinates are always displayed, as is the option to Delete 
Geo-Tag(s). Other displayed information may include a photo 
thumbnail, the number of photos associated with the Geo-Tag location, 
and the option to view slideshow. 

Map boundaries (for Smart albums)  

If you create smart albums (see p. 29), you can restrict your album 
content to photos from specific geographic areas, called map 
boundaries. These boundaries can be drawn around islands, cities, and 
countries, even around theme parks and venues. In fact, any geographic 
region where a concentration of photos have been taken. 

Before creating your smart album, map boundaries need to be created. 

To create map boundaries: 

1. On the Edit menu, select Map Boundaries. 

2. From the Map Boundaries dialog, zoom into the appropriate 
level on the Google™ map. 

3. Click New to allow you to draw your new map boundary. 

4. On the map, click repeatedly around your chosen boundary, 
drawing straight segmented lines as you go. You can pan and 
zoom as you draw your boundary. 
 
Click back on your starting point (the cursor will change to a 
hand) to close the area. 
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5. In the Boundary Name dialog, type a name for your boundary, 
e.g. Paradise Island, and click OK. 

6. (Optional) Repeat the process for additional boundaries by 
clicking New. 

Once you've created one or more map boundaries, you can create a 
smart album (p. 29) from the Organize tab which is restricted to photos 
taken within those map boundaries. 
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Filter by album 

If you have assigned photos to albums, you can use an album to filter 
and display only photos within that album. 

To filter by album: 

• On the Organize tab, select an album name. 
 

 

 Use Shift-click or Ctrl-click to include more than one adjacent or 
non-adjacent album in filtering, respectively. 
 

 
 

Photos assigned to the selected album(s) will be displayed in the Library. 

Smart albums 

You can filter by Smart albums in an identical way to Albums by 
selecting any number of smart albums. 
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Filter by folder 

Filter by folder lets you filter by the folders that you previously selected 
to be included in PhotoStack. 

To filter photos by folder: 

• On the Organize tab, select a folder name. 
 

 

 Use Shift-click or Ctrl-click to include more than one adjacent or 
non-adjacent folder in filtering, respectively. 
 

 
 

The photos from selected folder(s) are displayed in the Library. 
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Filter by date 

Filter by date lets you filter photos according to when they were taken. 

Your Date taken times are present in the Organize tab, and are initially 
collapsed by default. 

To filter photos by date: 

1. On the Organize tab, click the Date taken category's  expand 
button. 
 

 

2. Select a date. This is the time that the photo was taken (see 
Viewing and adding metadata on p. 49). 
 

 
 
OR 
 
Use Shift-click or Ctrl-click to include more than one adjacent 
or non-adjacent date in filtering, respectively. 
 

 
 

The photos taken on the selected date(s) are displayed in the Library. 
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Filter by tag 

If you have assigned tags to your photos, you can use a particular tag to 
display only photos that have that tag assigned to them.  

In advance of filtering, you can either utilize the tags within added 
photos, use PhotoStack's preset tags, or create your own user-defined 
tags (see p. 40).  

To filter by tag: 

1. On the Organize tab, click the Descriptive tags category's 
 expand button (if necessary). 

2. Select the tag name. 
 

 

 Use Shift-click or Ctrl-click to include more than one adjacent or 
non-adjacent tag in filtering, respectively. 
 

 
 



Filtering 65 

 

Photos with that tag assigned will be displayed in the Library. 

 Preset tags are typically action-based to aid workflow, i.e. Reviewed, 
To Fix, To Print, and To Share. 

Not tagged status 

The Not tagged tag will let you view photos that have no tags assigned. 
This can be used to separate your "processed" photos from 
"unprocessed" photos—newly imported photos will often not have 
assigned tags. As you process your photos you can use the Not tagged 
tag to check your progress. 

Quick tags 

You can filter by Quick tags in an identical way to Descriptive tags by 
selecting either Not flagged, Flagged, Not rejected, Rejected, or any 
combination of these. 
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Filter by rating 

Filter by rating lets you display photos that have been assigned a specific 
"star" rating level. You can equally filter by unrated photos for future 
rating. 

 Stars have to be assigned to photos in advance, as described in 
Rating your photos on p. 43. 

To filter photos by rating: 

• On the Organize tab, select a rating. 
 

 

 Use Shift-click or Ctrl-click to include more than one adjacent or 
non-adjacent rating level in filtering, respectively. 
 

 
 

The photos that match the rating level exactly are displayed in the 
Library. 
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Manipulating photos 

PhotoStack lets you perform commonly used photo editing operations. 
It is also highly likely that at some times the photos you've taken haven't 
turned out as well as expected. Don't worry, you'll be able to quickly 
correct any photos within PhotoStack to radically improve your end 
results. 

Here's a quick summary of operations available. 

• Use Develop view to make various adjustments to your photo, 
including: 

o Retouch tools such as red eye, spot repair, crop, and 
straighten. 

o Essential adjustments such as white balance, lighting, 
curves, levels, clarity and vibrance. 

o Various sharpen, blur, black & white, lens, and colour 
effects. 

• Flip your photo horizontally or vertically. 

• Open your photo in PhotoPlus for advanced photo editing. 

• Rotate your photo clockwise or anti-clockwise in 90° intervals. 
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Applying adjustments 

Develop view provides an image adjustment environment within 
PhotoStack which simplifies the often complicated process of image 
correction.  

Adjustments overview 

Develop offers the following key features: 

• Adjustment presets 
Apply tonal, colour, lens, and sharpening adjustments using the 
Presets tab.  

• Retouching tools 
Red-eye correction, spot repair, clone, and crop/straighten. 

• Custom presets 
Create individual or cumulative adjustments, and save 
adjustments. 

• Selective masking 
Apply adjustments to selected regions using standard and 
gradient masks. 

• Viewing controls 
Compare before-and-after previews, with tiled- and split-screen 
controls (horizontally and vertically). Use pan and zoom 
control for moving around your photo. 
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Adjustments 

Develop view displays your zoomed-in photo next to some adjustment-
related tabs to help you correct your photo. 

 

• Presets tab. Select from a range of categorized presets, without 
the need for any prior knowledge of adjustment settings.  

• Adjustments tab. For more professional control, select one or 
more filters and adjust settings to your custom requirements. 

• Histogram tab. Use the tab for a "heads-up" of the colours used 
in your photo.  

• History tab. The tab displays a history of previous edits that 
you can revert back to if needed. 
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To apply an adjustment (using a preset): 

1. From above your workspace, click  Develop. 

2. From the Presets tab, scroll the tab to review the categorized 
adjustment presets. 
 

 

3. Click a preset thumbnail to apply. 

To apply an adjustment (using specific adjustments): 

1. From above your workspace, click  Develop. 

2. From the Adjustments tab, scroll down the tab to review each 
adjustment. 
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3. Open a category or adjustment by clicking its  button. 

4. Modify the adjustment using sliders, check boxes, graph 
adjustments, and drop-down menus (you can also enter 
absolute values into available input boxes). The image will be 
adjusted automatically to reflect the new settings. 

 Once an adjustment setting is altered, the  Enable/disable this 
filter option becomes greyed out ( ). 
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Resetting and reverting adjustments  

Develop lets you "undo" changes and revert to an earlier edited version 
of the photo. 

To undo your changes: 

• From the History tab, select a previously applied 
preset/adjustment entry to which you want to revert back to. If 
you click 'Root' this will undo all your adjustments. 
 

 

 The previous presets/adjustments will still appear in the history, but 
will no longer be applied, and will automatically be replaced by any 
newly applied adjustment. 

To reset specific adjustments: 

• From the Adjustments tab, click  Reset settings at the top 
right of the currently applied adjustment. 
 

 

Sometimes you may adjust a photo and, at a later date, have second 
thoughts about the changes that you have made. PhotoStack is designed 
to ensure that you can get back to your original photo after exiting 
Develop. This is done by reverting to the original file. 
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To revert a photo back to its original: 

1. Select the photo thumbnail you want to revert changes on. 

2. From the Edit menu, select Revert to Original.  

Saving adjusted photos 

PhotoStack is able to save any photo-editing stage to a new photo. 
Typically, you'd save the most recent photo by selecting the most recent 
history entry.  

To save as a newly named photo (while in Develop view):  

1. From the History tab, select an applied adjustment/effect entry. 

2. Click the tab's  Tab Menu and select Save as New Photo. 
 
OR 
 
Right-click an entry and select the same option.  

3. From the dialog, navigate to a new location, and enter a new 
file name. 

4. Click OK.  

To save your photo (on exit from Develop view):  

1. Click another view (e.g. Library). 

2. From the dialog, choose Yes (to save) or No (to discard your 
edits). 
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Saving as a new preset 

If you've found an adjustment, or combination of adjustments, to your 
liking, you can save it as a preset in the Presets tab for future use. 

1. From the Adjustments tab, click  Save current 
adjustment to presets.  

2. From the dialog, add a preset Name and either: 

3. Select a category from the Category drop-down list. 
 
OR 
 

Click  Add New Category to save the preset to your own 
custom category, e.g., MyPresets. 

Your preset will appear at the end of the chosen category. 

Retouching adjustments 

PhotoStack comes equipped with a range of commonly used retouching 
tools. Each tool is designed to correct regions of your photos and make 
your shots picture perfect. 

 The retouching tools can be found on the Adjustments tab to the 
right of the workspace, when in Develop view. 

 When you've applied a retouching adjustment, make sure you click 
Apply on the Adjustments tab. If you don't, your changes may be 
discarded when you exit Develop view.  
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Red-eye removal 

Red eye is caused when the light from the flash of a camera reflects in a 
subject's eyes the moment a photo is taken. Many modern camera have a 
special flash mode to help minimize this effect, but don't worry if you've 
forgotten to switch it on—it's really easy to remove red eye in 
PhotoStack.  

 

To remove red eye: 

1. Select the  Red-eye tool from the toolbar at the top of the 
Adjustments tab.  

 Zoom in using the zoom tools at the bottom of the workspace for a 
better view, if required.  

2. Click once on the eye to set a default correction size. 
 
OR  
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Click and drag to draw a square around the red area. You'll see 
the red eye disappear as you drag. 

3. Resize the selection using the resize handles and move it into 
position if required.  

 You can delete a selection at any time by clicking  Delete 
Selection on the Adjustments tab.  

4. When you're happy, click Apply on the Adjustments tab.  

Spot Repair 

Spots and blemishes have the habit of showing up at the most 
inconvenient times, and can often look quite unsightly in photos. 
However, you can quickly remove these imperfections and leave the 
subject in your photos looking flawless.  
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To remove blemishes: 

1. Select the  Spot-repair tool from the toolbar at the top of 
the Adjustments tab.  

 Zoom in using the zoom tools at the bottom of the workspace for a 
better view, if required.  

2. (Automatic) Click on the spot or blemish to set a default 
correction size.  
 
OR  

• (Manual) Set the tool's Size and Opacity, and choose a Type. 

o Heal - Repair by blending the existing pixels with 
pixels in the new selection.  

o Clone - Repair by replacing the existing pixels with 
pixels in the new selection.  

• Click on the blemish to define the target area and then drag to 
select a suitable pickup area to replace the blemish (the outlined 
target area updates as you drag). 

3. Release the mouse button. 

 You can delete a selection at any time by clicking  Delete on 
the Adjustments tab.  

4. When you're happy, click Apply on the Adjustments tab.  
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Clone Selection 

You may have photos which appear to be spoiled by a cluttered 
background or other flaws. Fortunately, you can correctly this easily by 
copying, or cloning, a section from another area of the photo over the 
unwanted area.  

 

To clone an area: 

1. Select the  Clone Selection tool from the toolbar at the top 
of the Adjustments tab.  

 Zoom in using the zoom tools at the bottom of the workspace for a 
better view, if required.  

2. Set the tool's Size, Opacity, and Feather, on the Adjustments 
tab. Decreasing the opacity will help the cloned area blend in 
with the rest of the photo.  

3. Shift-click on an area of the photo to define a pickup area.  
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4. With your cursor, paint over the area of the photo that you 
want to remove. The crosshair cursor indicates where you are 
copying from.  

 You might find that you need to Shift-click to define the pickup 
area again, for example if the crosshair cursor gets too close to other 
areas of the photo and you end up copying those by mistake. This is 
good practice as it also helps reduce repeated patterns.  

5. When you're happy, click Apply on the Adjustments tab.  

Crop and straighten 

Cropping is the process of removing areas from your photo, and is the 
equivalent of using scissors to trim a printed photo. It's a really useful 
technique for improving the composition and visual impact of a photo, 
by "zooming in" on a subject, changing the canvas orientation or even 
changing the aspect ratio for printing. In PhotoStack, you can quickly 
crop your photo to a custom or print size, and also straighten the 
horizon, if required.  
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To crop and straighten your photo: 

1. Select the  Crop & Straighten tool from the toolbar at the 
top of the Adjustments tab.  
 
A rule of thirds grid will appear on your photo.  

2. Choose an Aspect Ratio from the drop-down list.  
 
OR  
 
Drag your photo beneath the grid for manually positioning. 
Resize it with the resize handles if required.  

 For best results, position the subject of the photo at any of the four 
intersection points of the grid.  

o  Toggle between landscape and portrait (may 

initially display as ) to change the orientation of the 
grid on your photo.  

o  Click this button to lock the aspect ratio of the 
crop. 

3. (Optional) To straighten your photo, select the  Straighten 
tool on the Adjustments tab.  

o Click and drag to set a new horizon for your photo.  

o Alternatively, use the Angle slider to straighten using 
photo rotation.  

 You may need to reposition the rule of thirds grid once you've 
straightened the horizon of your photo.  

4. When you're happy, click Apply on the Adjustments tab.  
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Adjustment masks 

While in Develop view, masking is used to "paint" regions of your photo 
to which adjustments are either applied to or protected from. Without 
masking, any adjustment is applied to all of the photo. 

 

Two types of masking are possible in PhotoStack: standard masking 
(above) and gradient masking (below). The former paints a region to 
which the adjustment is applied to uniformly (or excluded from). The 
latter applies a gradient that increases the intensity of the mask across 
the region (and hence any adjustment).  

 

In the above example, a gradient mask has been applied at the bottom of 
the picture which allows an exposure adjustment to be utilized just 
between the bottom of the photo and the horizon line.  
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Each new mask comprises the selected mask region, plus a set of 
adjustments applied to that mask. You can change the adjustments 
associated with the mask at a later date.  

Standard masks 

To apply a standard mask: 

1. Select  Develop at the top of your workspace. 

2. Click the Adjustments tab at the right of your workspace. 

3.   Select Create mask from the top of the tab. The Mask 
entry appears which can be opened by clicking Expand. 

4. (Optional) Adjust the settings to suit your requirements. For 
example, choose one of the following options: 

o Size: The size of the mask brush. 

o Feather: Use to control the softness of the brush 
selection edge. 

o Density: Controls the density of paint laid down as 
you apply it, like "layering up" a brush then painting. 

o Tolerance: Drag the slider right or left to increase or 
decrease control. 

o Edge detection: By default, mask painting intelligently 
paints only to photo edges and not beyond. Edges are 
highly contrasting adjacent pixels that delimit areas of 
your photos, e.g., the horizon line between sky and 
land. 
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o Erase Brush: Check this option if you want to erase 
areas of your previously drawn mask., e.g. if you want 
to touch up poorly-painted mask edges.  

o Live Paint: When checked, as you paint, any 
adjustment already applied will show on the mask. 
Otherwise, only the mask is shown. If you enable any 
adjustment, this option is enabled by default.  

5. Using the  cursor, paint the regions to be masked in red. 

6. (Optional) Click the Invert option to invert your mask, i.e. 
areas that were masked become unmasked (and vice versa).  

7. Apply your adjustments from the Presets or Adjustments tab, 
which will make a change to your masked regions. 

8. Click on  Create mask again to deactivate masking. 

To delete a mask: 

• In the Mask settings pane, click Delete. 

Gradient masks 

Unlike a standard mask, a gradient mask increases the intensity of the 
mask across your photo. Such masks are great for accentuating sunsets, 
increasing exposure and saturation over a gradient, and for graduated 
special effects.  
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To apply a gradient mask: 

1. Select  Develop at the top of your workspace. 

2. Click the Adjustments tab at the right of your workspace. 

3.   Select Gradient mask from the top of the tab. The 
Gradient entry appears which can be opened by clicking 
Expand. 

4. Click and drag on your photo, from the point you want to start 
your gradient (e.g., from a horizon line downwards). Release 
the mouse button, where the gradient will finish. The gradient 
occupies the region between the outer lines. 
 

 

  You can also click to add the gradient mask to the centre of 
your photo then reposition it by dragging the mask marker. 

5. Applied adjustments will be faded out in the direction in which 
you drag. If you drag bottom to top, the adjustment will be 
strongest at the bottom of the photo, and fade out further 
towards the top. 

6. (Optional) Drag the outer lines inwards or outwards (above) to 
adjust the extent of the gradient. 
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7. (Optional) To tilt the mask from horizontal, hover anywhere 
along the rotation line that intersects the mask marker until 
you see the  cursor, then drag up or down. Alternatively, use 
the Adjustments tab's Angle slider. 
 

 

8. Apply your adjustments from the Presets or Adjustments tab, 
which will make a change to your masked regions. 

9. Click on  Gradient mask again to deactivate gradient 
masking. 

To delete a mask: 

• In the Gradient settings pane, click Delete. 

Adding multiple masks 

So far we've looked at an individual mask applied to a photo. However, 
PhotoStack also supports multiple masks where a different set of 
adjustments can be applied to each mask. You can therefore build up a 
patchwork of masked regions for absolute and selective control of photo 
adjustments. 
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To add additional masks: 

• Click New in the Mask or Gradient pane, then apply a new 
mask region as before, and apply your adjustments. 

To edit or delete a mask: 

1. With the relevant mask tool selected, click on the  mask 
marker on your mask. 

2. Modify your adjustments, or click Delete. 

Selecting/deselecting masks 

After you create a second mask, two black mask markers will remain on 
your page. Each marker can be selected individually to allow each mask's 
settings to be adjusted. 

Rotating and flipping photos 

For photos from more basic (or legacy) cameras, scanned images, or 
intentional portrait shots (showing in a landscape orientation) you may 
need to manually rotate your photo to its intended orientation; typically 
by a rotation of 90° clockwise. Of course, you may also choose to rotate 
any photo for artistic reasons at any time. 

To rotate a selected photo in 90° intervals: 

• Select Rotate Left 90° or Rotate Right 90° from the Edit 
menu's Rotate flyout. 
 
OR 

• Right-click and select the equivalent option from the Rotate 
flyout. 
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To flip a selected photo horizontally or vertically: 

• Select Horizontal Flip or Vertical Flip from the Edit menu's 
Flip flyout. 
 
OR 

• Right-click and select the equivalent option from the Flip 
flyout. 

Editing photos in Serif PhotoPlus 

If you own Serif PhotoPlus you'll be able to perform professional editing 
of your photo in PhotoPlus, launched directly from within PhotoStack. 

To launch and edit a photo in Serif PhotoPlus: 

1. Select a photo thumbnail. 

2. From the Edit menu, select Edit in PhotoPlus. 
 
OR 
 
Right-click the thumbnail, choosing the same option. Serif 
PhotoPlus will be launched automatically (if installed). 

3. Make your image adjustment in PhotoPlus, ensuring that you 
use the Save or Save Original (depending on your version of 
PhotoPlus) option on the PhotoPlus File menu to save your file. 
Changes made will be shown in PhotoStack—your photo 
thumbnail will update automatically. 
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Creating panoramas 

If you have Serif PanoramaPlus installed, you can create seamless 
panoramas from your photos. 

To create a panorama: 

1. In the Library, select the photos that you want to "stitch" 
together. Use Shift-click or Ctrl-click to select adjacent or non-
adjacent photos, respectively. 

2. From the Edit menu (or via right-click), select Create 
Panorama. 

3. PanoramaPlus opens and your photos are automatically 
stitched together as a panorama. 

4. (Optional) Straighten, rotate, and/or crop your panorama in 
PanoramaPlus using buttons on the main toolbar. See 
PanoramaPlus Help for more details. 

5. Click Save (or Save As) to save your panorama to a new 
project. 
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Adding photos to CraftArtist 

If you have Serif CraftArtist installed, you can start getting creative with 
your photos by creating one of a choice of CraftArtist projects—your 
photos will then be available to add to the page. 

 This feature requires CraftArtist version 1.0.5.x (or above). If 
necessary, please upgrade to the latest version via CraftArtist's Help 
menu, selecting Check for Update from Web.  

To add photos to CraftArtist: 

1. Select one or more thumbnails. Use Shift-click or Ctrl-click to 
select adjacent or non-adjacent photos, respectively. 

2. From the Edit menu (or via right-click), select Create Photo 
Project, then choose one of the following submenu options: 

o New Photo Project: Photos are added to a new 
CraftArtist project; Page Setup is launched for you. 

o Create Card: A Greeting Cards Craft Project is 
selected, offering selectable card-specific templates. 

o Create Scrapbook: A Scrap Pages Craft Project is 
selected, offering selectable scrap page templates. 

3. Continue developing your project in CraftArtist. For assistance 
with using CraftArtist, see CraftArtist Help (press F1). 

 Your photos are automatically added to the Photos tab for use in 
your project. 

 If you've already got CraftArtist open, the Add Photos to Project 
menu option adds your photos automatically to the Photos tab of 
your currently open and selected CraftArtist project. Simply jump to 
CraftArtist and your photos will be available to you. If CraftArtist is 
not running, the behaviour when using the New Photo Project 
option will occur. 
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Sharing photos 

PhotoStack lets you effortlessly share your photos with friends, family, 
and colleagues in various ways. You'll be able to use various one-click 
adjustment presets and take advantage of controllable image export 
quality and watermarking (p. 112), all depending on the sharing 
method.  

The following sharing methods are possible. 

 

• Export photos to files (see 
p. 100). 

 

• Print photos to your local 
printer (see p. 102). 

 

• Send photos via email (see 
p. 103). 
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• Upload your favourite albums 
and photos to Facebook (see 
p. 105). 

 

• Upload photos to Flickr (see 
p. 107). 

 

• Upload photos to Dropbox 
online storage (see p. 109). 
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The Share dialog 

Sharing your photos takes place from a single Share dialog in 
PhotoStack. 

 

The dialog is fully optimized for easy sharing. 

Sharing options 

Options differ in the Share dialog depending on how you want to share.  

 

If you click on any of the above options, the dialog changes to be specific 
to that type of sharing. Selection of the Upload button provides sharing 
via Facebook, Flickr, Dropbox, and YouTube (video only).  
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Choosing items for sharing 

For any sharing option, you have the ability to share the currently 
selected photos, all photos in a previously created album, or photos in a 
Quick album. A Quick album is an excellent way to temporarily collect a 
set of photos together purely for the purpose of sharing. 

 

Sharing-specific options 

PhotoStack provides options that are specific to the type of sharing 
required: 

• For Export Images: export Location creates your exported files 
in this folder location. 

• For Print: Printer lets you select your desktop or network 
printer. 

• For Email: Email lets you create an email with attachment or 
save to folder for later upload. 

• For Upload: Facebook, Flickr, Dropbox, or YouTube options 
for sharing to. 

Selecting presets 

Presets make life easier, by grouping typical settings together under one 
option. Simply click and your adjustment(s) are applied in one action. 
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Depending on the type of sharing (e.g., export, print, email, or upload), 
the preset thumbnails available may differ. Often, the presets offer only 
slight variations between each other.  

Share 
option 

Thumbnail 
 example 

Thumbnail 
options 

Export 

 

Photo quality options, 
metadata control, 
watermark options. 

Print 

 

Multi-picture layouts 
(using various paper 
sizes), CDs, passport, 
and contact sheets. 
Designer multi-picture 
layouts. 

Email 

 

Photo size options, 
Photo quality options, 
compression and 
watermark options.  

Upload 

 

Photo quality options, 
watermark options, 
gallery sizes. 

Custom settings 

See Custom sharing settings in PhotoStack Help. 
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Sharing 

 Once you've selected your sharing options, in the bottom-right 
corner of the dialog, click Export, Print, Email, or Upload to start 
sharing your photos. 

Exporting to another file format 

In many situations, you'll want to save a file to one of the standard 
graphics formats that everyone can access. In PhotoStack, this is known 
as exporting.  

 Exporting leaves your original file intact, so you can come back and 
edit it at any time.  

Exporting images 

To export an image: 

1. (Optional) If exporting specific items only, select one or more 
thumbnails. Use Shift-click or Ctrl-click to select adjacent or 
non-adjacent items, respectively. 

2. From above your workspace, click  Share. 

3. From the Share dialog, click  Export Images. 

4. Select an Items to Export option. 

o Selection: Includes only the previously selected items 
in the export. 
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o Quick Album: Only the items in your Quick Album 
are exported. 

o Album: Only the items in your created album are 
exported. Select the named album from the adjacent 
drop-down list. 

 If you've chosen to export multiple photos, a thumbnail image of 
each one will be displayed at the bottom of the Preview pane on the 
right. Click on a photo to see a larger preview.  

5. Your photos will automatically be saved to the default pictures 
location on your computer, and this location will be displayed 
in the Location section. To change this, click Browse and then 
navigate to where you want to save your photo(s).  

6. Select a preset thumbnail for the quality and size of the 
photo(s) to be exported. Alternatively, create custom sharing 
settings (see PhotoStack Help). 

 In the Preview pane you'll be able to see the current file type and 
size for each photo.  

7. Review your photos and, when you're happy, click Export at 
the bottom right of the dialog.  

Next time you navigate to the location you specified in the Share dialog, 
you will see your exported photo(s).  

 You can experiment with different file formats and their specific 
settings in the Image File Type section of the Custom tab.  
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Printing 

For basic printing primarily to desktop printers, PhotoStack's Print 
feature offers an exciting, comprehensive, and versatile printing solution 
for your photos. 

To print an image: 

1. (Optional) If printing specific items only, select one or more 
thumbnails. Use Shift-click or Ctrl-click to select adjacent or 
non-adjacent items, respectively. 

2. From above your workspace, click  Share. 

3. From the Share dialog, click  Print. 

4. Select an Items to Print option. 

o Selection: Includes only the previously selected items 
in the printout. 

o Quick Album: Only the items in your Quick Album 
are printed. 

o Album: Only the items in your created album are 
printed. Select the named album from the adjacent 
drop-down list. 

5. Select a currently installed printer from the drop-down list in 
the Printer section. If necessary, click the Properties button to 
set up the printer for the correct page size, etc.  

6. Select a preset thumbnail for the quality and size of the 
photo(s) to be printed. Alternatively, create custom sharing 
settings (see PhotoStack Help). 
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The Preview pane on the right will update dynamically each 
time you select a preset. Depending on your chosen settings, 
the number of pages may update too.  

7. Review your chosen layouts in the Preview pane. Use the arrow 
buttons to view other pages of your printout, if required.  

 By default, Auto Populate will be selected. Uncheck this checkbox 
to manually select which photos will be included in your printout.  

The number displayed on each photo indicates how many 
times it has been used in the print layout.  

8. When you're happy, click Print at the bottom right of the 
dialog.  

Using email 

The widespread availability of the Internet means that most people’s 
family and friends are now only a quick email away. PhotoStack uses 
your default email client to send photos. 

 Due to excessive file sizes, video files cannot be included as email 
attachments.  

 An Internet connection is required for the emailing of pictures. 

To email photo(s): 

1. (Optional) If uploading specific items only, select one or more 
thumbnails. Use Shift-click or Ctrl-click to select adjacent or 
non-adjacent items, respectively. 

2. From above your workspace, click  Share. 



104  Sharing 

 

3. From the Share dialog, click  Email. 

4. Select an Items to Email option. 

• Selection: Includes only the previously selected items to 
email. 

• Quick Album: Only the items in your Quick Album are 
emailed. 

• Album: Only the items in your created album are emailed. 
Select the named album from the adjacent drop-down list. 

5. By default, Attach to new email message will launch your 
email program and attach your files to a new message. 
Otherwise, you can save your email to a file location using Save 
to folder. 

6. Select a preset thumbnail for the quality and size of photo to be 
uploaded. Alternatively, create custom sharing settings (see 
PhotoStack Help). 

7. Click Email at the bottom right of the dialog. 

8. From your currently open or launched email program, an email 
message is created with your photo(s) attached. Click the Send 
button when your email is completed. 

 An Internet connection is required for the emailing of pictures. 
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Uploading to Facebook 

Facebook is a social networking website that enables you to keep in 
touch with friends, and amongst other things, upload an unlimited 
number of photos. In PhotoStack, your photos can be shared with 
friends and family in just a few clicks! 

 A working Facebook login is required to upload your photos. If you 
don't have a login, visit www.facebook.com and register or do this 
at upload time! 

To upload photos to Facebook: 

1. (Optional) If uploading specific items only, select one or more 
thumbnails. Use Shift-click or Ctrl-click to select adjacent or 
non-adjacent items, respectively. 

2. From above your workspace, click  Share. 

3. From the Share dialog, click  Upload. 

4. Select an Items to Upload option. 

• Selection: Includes only the previously selected items in 
the upload. 

• Quick Album: Only the items in your Quick Album are 
uploaded. 

• Album: Only the items in your created album are 
uploaded. Select the named album from the adjacent drop-
down list. 

5. Enable the Facebook option under the Account section. 

http://www.facebook.com/
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6. Select a preset thumbnail for the quality and size of photo to be 
uploaded. Alternatively, create custom sharing settings (see 
PhotoStack Help). 

7. Click Upload at the bottom right of the dialog. 

8. In the Facebook Login dialog, log into your Facebook account. 
Type in your email address and password and click Log in. 

 

9. The Destination Album dialog appears. Once logged on to 
Facebook this dialog will show immediately after clicking 
Upload. 
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• Select New Album to create a new Facebook album. Enter 
a name for your new album in the Name: text box. 

• Select Existing Album to upload photos to an album that 
has been created previously in Facebook. 

• Click OK. 

10. The photo upload will begin. 
 

 

The progress bar indicates the status of the export and upload 
processes. Click the  icon to cancel any upload currently in 
progress. When the upload is complete, it closes automatically.  

Once your photos have been uploaded, your default web 
browser opens. 

Finding your albums on Facebook  

Your Facebook albums will appear in Facebook—click on your profile 
photo, then select the Photos category. Your albums are listed under 
album name. 

Uploading to Flickr 

Flickr is an online photo and video management website. It is a great 
place to share your photos with people all over the world. PhotoStack 
makes it easy to upload your favourite photos. 
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 A working Flickr account is required to upload your photos. This can 
be your Yahoo! ID, or your existing Google or Facebook login 
details. If you don't have a login ID or account, you can create one 
the first time you upload your photos. Alternatively, register at 
www.flickr.com. 

To upload photos to Flickr: 

1. (Optional) If uploading specific items only, select one or more 
thumbnails. Use Shift-click or Ctrl-click to select adjacent or 
non-adjacent items, respectively. 

2. From above your workspace, click  Share. 

3. From the Share dialog, click  Upload. 

4. Select an Items to Upload option. 

• Selection: Includes only the previously selected items in 
the upload. 

• Quick Album: Only the items in your Quick Album are 
uploaded. 

• Album: Only the items in your created album are 
uploaded. Select the named album from the adjacent drop-
down list. 

5. Enable the Flickr option under the Account section. 

6. Select a preset thumbnail for the quality and size of photo to be 
uploaded. Alternatively, create custom sharing settings (see 
PhotoStack Help). 

7. Click Upload at the bottom right of the dialog. 

8. The Flickr Login dialog opens. If necessary, type in your 
Yahoo!, Facebook, or Google login details and click Sign In. 

http://www.flickr.com/
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 Once logged in you won't need to enter login details, but you may 
need to authorize uploads to Flickr from PhotoStack. Follow the 
instructions in the dialog. 

9. When prompted that you may close the window, click 
Continue at the bottom of the dialog to start the photo upload. 
 

 

The progress bar indicates the status of the export and upload 
processes. Click the  icon to cancel any upload currently in 
progress. When the upload is complete, it closes automatically.  

Once your photos have been uploaded, your default web 
browser opens. In the Describe this upload page, you can give 
your photos tags, a title, and a description. Click Save to update 
the information. Close the browser window to return to 
PhotoStack. 

Uploading to Dropbox 

Dropbox is an exciting way to share your photos with family, friends, 
and colleagues. By using a single shareable online location, you can 
consolidate your media and access them at any time via a range of 
mobile and desktop devices.   

Pre-requisites 

You'll need to sign up to Dropbox via their dropbox.com website. 
Following this, download the Dropbox program from the site and install 
it on your computer. 

https://www.dropbox.com/
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To upload photos to Dropbox: 

1. (Optional) If uploading specific items only, select one or more 
thumbnails. Use Shift-click or Ctrl-click to select adjacent or 
non-adjacent items, respectively. 

2. From above your workspace, click  Share. 

3. From the Share dialog, click  Upload. 

4. Select an Items to Upload option. 

• Selection: Includes only the previously selected items in 
the upload. 

• Quick Album: Only the items in your Quick Album are 
uploaded. 

• Album: Only the items in your created album are 
uploaded. Select the named album from the adjacent drop-
down list. 

5. Enable the Dropbox option under the Account section. 

6. Select a preset thumbnail for the quality and size of photo to be 
uploaded. Alternatively, create custom sharing settings (see 
PhotoStack Help). 

7. Click Upload at the bottom right of the dialog. 

8. From the launched Dropbox sign-in web page, enter your email 
address and password and click Sign in. 

 You'll need to authorize PhotoStack to access your Dropbox 
account each time you upload. When prompted, click the Allow 
button. 
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9. The Dropbox Folders dialog appears. Select a folder from the 
list or alternatively, use subfolders. Simply select the folder that 
you wish to be the parent, enter your folder name, and click 
New Folder. Select the sub-folder before upload. 
 

 

10. Click OK. 

11. The photo upload will begin.  
 

 
 
The progress bar indicates the status of the export and upload 
processes. Click the  icon to cancel any upload currently in 
progress. When the upload is complete, it closes automatically. 
Once your photos have been uploaded, you can access your 
photos and make them sharable using the tools available on 
Dropbox.  
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Creating slideshows 

All or selected photos can be presented in a simple ready-to-go 
slideshow. With an attractive panning transition between each photo 
you can be sure to impress friends and family alike. 

To create your slideshow: 

1. Select one or more thumbnails. Use Shift-click or Ctrl-click to 
select adjacent or non-adjacent photos, respectively. 

2. From the View menu, select Slideshow.  

The slideshow is displayed in full screen mode with a supporting 
slideshow control to control playback, i.e. press the Previous, Pause 
(Play) or Next buttons in your slideshow control. 

 Press the ESC key on your keyboard to exit the slideshow at any 
time. 

Watermarking photos 

Placing a visual copyright watermark, symbol or caption on your photo 
is a great way of protecting it from unauthorized use. This is because 
using watermarks identifies the creator of a photo and also indicates 
ownership.  
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Adding a watermark 

To select a watermark preset:  

1. On the toolbar above your photo, click  Share.  

2. At the top of the dialog, choose how you want to share your 
photos.  
 

 

3. On the Presets tab, browse the watermark presets available, and 
then select the one you want to use. The watermark presets 
available may change depending on the share option you've got 
selected.  

4. Continue sharing your photos as you would normally.  
 
Your shared photo(s) will appear with watermarks applied.  
 

 

PhotoStack also lets you use other watermarks as you are sharing.  
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To select an alternative watermark:  

1. Select the Custom tab. 

2. Expand the Watermarks category, then select which 
watermarks you want to use from the Watermarks available 
list. 

3. Click Add. 

For more details, see custom watermark settings (see PhotoStack Help). 

 Some watermarks will show as a cross (above), show a padlock 
symbol, or display the text 'CONFIDENTIAL'. Additionally, some 
presets allow you to add you own text using watermark 
placeholders.  

Editing watermarks 

You can edit your watermark design, including the watermark text 
displayed and any overlaid images you might want to use. 

When you select a sharing preset with a label "Company Name" or 
"Watermarked", your previewed photo will show a watermark displaying 
"My Company" and the year. It therefore makes sense to change the 
watermark to reflect your own details!  
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To edit your watermark: 

1. In the Share dialog, with your preset selected, select the 
Custom tab.  

2. Click  to expand the Watermarks category. 

3. Click Edit Watermarks at the bottom of the window.  

4. Select a Watermark on which to base your watermark from the 
Watermarks list. 

5. From the Text section, enable Text, and replace placeholder 
text in the Text field.  
 

 
 
Apply any text attributes, effects, and add symbols as 
appropriate. 
 
AND/OR 
 
From the Image section, enable Image, then navigate to and 
select your image. The additional options lets you apply a drop 
shadow, Scale the image in relation to the chosen Layout 
positional aid (click a dark square to set the image's anchor 
point), and select an Opacity level. 
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6. On the left of the dialog, click Create to save your watermark to 
use on future photos. 

7. Type a name for your new watermark, and click OK. Your 
watermark will appear in the Watermarks list on the left. 

8. Click Close.  

9. Now you need to add your watermark to the Watermarks used 
list. Select it in the Watermarks available list and then click 
Add.  
 

 
In the Preview pane on the right, your watermark will have 
been added to your photo.  

 Remove any unwanted watermarks from the list by selecting them 
and clicking Remove.  

10. When you're happy, simply continue sharing your photos as 
you would normally.  
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Contacting Serif 

Help with your Product 

On the web 

 

community.serif.com 
Get answers and ask questions in the Serif 
community! Type ‘PhotoStack’ to view only 
PhotoStack questions and answers. 

Serif Support www.serif.com/support 
For Serif Account and Customer Service 
information. 

Additional Serif information 

On the web 

Serif website www.serif.com 

Main office 

Address The Software Centre, PO Box 2000 
Nottingham, NG11 7GW, UK 

Phone (0115) 914 2000 

Phone (Registration) (0800) 376 1989 
+44 800 376 1989 
800-794-6876 (US, Canada) 

Phone (Sales) (0800) 376 7070 
+44 800 376 7070 
800-489-6703 (US, Canada) 

Customer Service 0845 345 6770 
800-489-6720 (US, Canada) 

Fax (0115) 914 2020 

http://community.serif.com/
http://www.serif.com/support
http://www.serif.com/
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Credits 

This User Guide, and the software described in it, is furnished under an end user License 
Agreement, which is included with the product. The agreement specifies the permitted and 
prohibited uses. 

Trademarks 

Serif is a registered trademark of Serif (Europe) Ltd. 

PhotoStack is a trademark of Serif (Europe) Ltd. 

All Serif product names are trademarks of Serif (Europe) Ltd. 

Microsoft, Windows, and the Windows logo are registered trademarks of Microsoft 
Corporation. All other trademarks acknowledged. 

Windows Vista and the Windows Vista Start button are trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or other countries. 

Copyrights 

This application was developed using LEADTOOLS, copyright © 1991-2007 LEAD 
Technologies, Inc. ALL Rights Reserved. 

Facebook © 2008 Facebook Inc. 

flickr © 2008 Yahoo! Inc. All Rights Reserved. 

Dropbox © 2008 Dropbox, Inc. 

YouTube © 2013 YouTube, LLC.  

Imagery © 2009 GeoEye, Infoterra Ltd & Bluesky, Getmapping plc 

Map data © 2009 Tele Atlas 

© 2013 Serif (Europe) Ltd.  All rights reserved. No part of this User Guide may be reproduced 
in any form without the express written permission of Serif (Europe) Ltd. 

Serif PhotoStack © 2013 Serif (Europe) Ltd. All rights reserved. 

Companies and names used in samples are fictitious.
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adding photos 
to CraftArtist, 91 

adjustments, 70 
masks, 83 
resetting/reverting, 74 
reverting photos after, 74 
saving, 75 
saving presets, 76 

albums, 25 
creating, 26 
populating, 28 
Quick, 28 
Smart, 29 

authors (credits), 49 
blemish removal, 78 
camera 

importing from, 14 
captions, 49 
card reader 

importing from, 14 
CD 

importing from, 15 
cloning, 80 
Contacting Serif, 119 
copyright, 49 
copyrights (product), 120 
CraftArtist, 91 
credits, 120 
crop/straighten, 81 
dates 

changing photo, 45 
filtering by, 63 

deleting, 49 
Develop view, 70 
Dropbox, 109 
DVD 

importing from, 15 

emailing, 103 
EXIF, 49 
exporting, 100 
external hard drives 

importing from, 14 
Facebook, 105 
features 

key, 4 
file conversion, 100 
filtering 

by album, 61 
by date, 63 
by folder, 62 
by rating, 66 
by tag, 64 

flash drive 
importing from, 14 

Flickr, 107 
flipping, 88 
folders 

filtering by, 62 
managing, 21 
watching, 16 

Geo-Tag, 54 
adding, 54 
deleting, 55 

grouping, 35 
importing, 13 

from CD/DVD, 15 
from USB device, 14 

Include folder, 16 
installation, 9 
IPTC, 49 
key features, 4 
Library, 3, 22 
local hard drives 
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